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Word processing

What is a word processor?
A word processor that deals with text-based material. It is possible to create a
document and then edit the text in the document. The document may be stored
on a disk or on a computer network. It can be retrieved from a disk, formatted
and published.

Text that has been created by a word processor and stored in a file is referred
to as a document. Using a word processor enables you to organise ideas and easily
change the text.

The electronic copy that has been created on a computer (sometimes called
‘soft copy’) can be changed and formatted in many ways before printing. Material
that is printed out is called ‘hard copy’.

When text is published it may be done electronically or by printing on paper.
Electronic publishing includes using:

• the World Wide Web
• an organisation’s intranet
• a CD-ROM or DVD.

There are many word-processing packages that can create and edit text. The
simplest of these is Notepad, part of Microsoft Windows.

Other word-processing packages include Microsoft Word and WordPerfect.
Integrated packages such as AppleWorks and Microsoft Works each include a

word-processing module.

Microsoft word is the most widely used word processing package. However, Sun
Microsystems Star Office is also becoming widely used.

Your turn
1 What are the names of the word-processing packages that you use:

a at home
b at school
c elsewhere?

2 What do you use this software for?

6

Figure 6.1 
a and b Notepad
and MS Word icons
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The word processor screen display
When you open the word processor to create a new document the screen will
have a number of features. Microsoft Word has:

• a pull down menu across the top of the screen
• a toolbar
• a window or area in which text may be entered
• a flashing cursor that indicates where to enter the text.

Your turn
1 Start the word processing package you normally use. How does it compare to the screen

display in Figure 6.2? List the similarities and the differences.
2 Can the screen display be altered by the user?

Writing with a word processor
When starting a new document, treat the computer screen like a blank sheet of
paper on which the main points are to be written. Enter the main points as a list
on the screen, pressing the ENTER key between each one. In the beginning there is
no need to form sentences or paragraphs.

Figure 6.2
Microsoft Word
screen
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Your turn
1 This exercise requires you to compose text using the keyboard.

Topic: What I like doing best.
a Make a list of the five main points (single words only) you want to include. Give the

document a name and save it.
b Form the list into an order.
c Form the words into sentences.
d Form the sentences into paragraphs.
e Print a copy of the document.

2 Write some text by hand. Then enter it on the word processor. Describe how entering 
text from handwritten copy is different from entering copy directly on the computer.

Saving documents
Documents must be saved regularly, especially after important changes have been
made. At the end of a session a backup copy should be made. Always allow
enough time at the end of a session to be sure that you are not in a hurry when
saving your documents.

Some word processing packages can be set to save documents automatically at a
regular interval, for example, every five minutes. When a document is saved, give
it a name that is related to its contents. For example, if you are writing a letter to
Joan, it could be named ‘Joanlettermay05’.

Microsoft Word has the option to always create a backup file. The backup file is
created with the name ‘Backup of …’.

Get into the habit of using the keyboard shortcut Ctrl + S to save.

Figure 6.3
Automatically saving
from the Tools
menu in Microsoft
Word
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Steps to document creation
Figure 6.4 shows the basic processes in document creation.

Your turn
Why is saving the document the most important step in the creation of a document? 
List two other important steps.

What is the cursor?
The cursor is a point of light on the computer screen. The on-screen cursor shows
the position where text may be entered. The cursor usually flashes to make it easy
to locate.

The cursor shape
There are a variety of ways in which the cursor will appear on the screen. The
most common way is as a flashing line.

If the cursor changes shape, this may indicate a change in the function that can
be performed. If the cursor becomes:
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• an I beam—the cursor has moved from its current insertion point
• an arrow—in the scroll bar it is used to move through a document.

Your turn
1 What is the shape of the cursor in your word processor?
2 How does the shape of the cursor change when it is moved to different parts of the

screen?

Inserting text
To insert text, place the cursor immediately to the left of where the next character
is to be entered and press a character key.

Deleting a single character
If the cursor is a vertical line, place it to the right of the character to be deleted
and press the BACKSPACE key. To delete the character to the right of the cursor,
press the DELETE key.

Word wrap around
When a line on the screen is full, words are automatically moved to the next line.
It is only necessary to press the ENTER key at the end of the paragraph. Word wrap
around is useful if the document is to be formatted again at a later date. For
example, if the margins are changed the line length will automatically fit the new
margins.

Your turn
Enter the following lines of text. Do not press the ENTER key at any stage.

The best thing about the holidays was the weather. It was terrific every day.
The sun was shining through the early morning mist and the wind was very light.

At what point did the text run on to the next line?

Your turn
1 Type the line below as it appears. Then make the changes to the line as shown by the

arrows.

2 Save a copy of the document. Call the document by your given name and add ‘Example 6’
after it. For example, if your name is Marika you would name the document ‘Marika
Example 6’. Microsoft Word will add the extension ‘.doc’ that is used to identify the type
of file.
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Selecting and deleting a block of text
If text is to be edited it has to be selected. To select text place the cursor at the
start of the text then:

• with the left mouse button held down, drag to the end of the text to be
selected, or

• hold down the SHIFT key and move the cursor to the end of the text to be
selected.

Selected text shows as reversed on the screen. For example, the following line
has been selected:

To delete a block of text, select the block and then press the 
BACKSPACE key.

Other ways of selecting text include:

• selecting a word—double click on that word
• selecting a line—move the mouse to the left margin and click when the cursor

changes to an arrow
• selecting a sentence—hold down the CTRL key and click anywhere in the

sentence
• selecting a paragraph—move the mouse to the left margin and double click

when the cursor changes to an arrow.

Moving text—cut, copy and paste
Text can be moved around a document after it has been entered. To ‘cut and
paste’ means to move text from one position to a new position. To ‘copy and
paste’ means to make a copy of the original text and place the copy somewhere
else in the document.

Figure 6.5 shows the cut and paste process.

Selected text is cut using the Cut command on the Edit menu. It is pasted into the
new position using the Paste command on the Edit menu.

Selected text shows as reversed on the screen

Original text Word processors, like other computer software, can ‘cut’ and ‘paste’
material. Remember that most software has an ‘undo’ function that can
reverse the most recent action.  A selected piece of text can be moved
to another position.

Text to be moved Word processors, like other computer software, can ‘cut’ and ‘paste’ 
is selected using material.  Remember that most software has an ‘undo’ function which 
the cursor can reverse the most recent action. A selected piece of text can be 

moved to another position.

Selected text is cut Word processors, like other computer software, can ‘cut’ and ‘paste’
material. A selected piece of text can be moved to another position.

Selected text is Word processors, like other computer software, can ‘cut’ and ‘paste’ 
pasted at the end material. A selected piece of text can be moved to another position.
sentence Remember that most of software has an ‘undo’ function which can

reverse the most recent action.

Figure 6.5
Steps to cut and
paste
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Your turn
1 Enter the text in Table 6.1 called ‘Original text’ (paragraph 1).
2 Using Cut and Paste change the paragraph to the same as 

paragraph 4.

Selected text can be copied and placed elsewhere in the document using the Copy
and Paste commands on the Edit Menu.This may be done a number of times with
text placed in a number of different positions. Figure 6.6 shows the steps involved.

Your turn
1 Carry out the exercise shown in Figure 6.6. Paste the text into the 

document three times.
2 How do you select the following on the word processor you are using:

a character
b word
c line
d paragraph
e entire document?

3 What is the difference between ‘cut and paste’ and ‘copy and paste’?
4 This exercise requires you to have more than one document open at the same time.

a Open two documents you have created.
b Select a paragraph of text from one document and copy it.
c Move to the other document and paste the text into it.

Figure 6.6
The Edit menu

Figure 6.7
Steps to copy and
paste

Original text Jackson College ‘Doing Your Best Always’

Original text is selected  Jackson College ‘Doing Your Best Always’

Copy text [Using mouse or keyboard commands]

Move cursor to new position Jackson College ‘Doing Your Best Always’
(in this case below original) Cursor

Paste text Jackson College ‘Doing Your Best Always’ Same text in
Jackson College ‘Doing Your Best Always’ two places
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The clipboard
When text is cut or copied, it is stored in the clipboard. When the Paste command
is used, it places the contents of the clipboard into the document wherever the
cursor is located.

In Microsoft Word, the clipboard can contain a number of different items and
different types of data, including images, and can be used to copy data:

• within documents
• between documents
• between applications.

The Clipboard toolbar provides access to the data. This is accessed as an item
on the Edit menu.

Drag and drop editing
Another way to cut and paste or copy and paste text is to use ‘drag and drop’.

To cut and paste, select the text and then place the cursor on the text. Now
drag the cursor to the new position and release the mouse button. The selected
text is moved to the new insertion point.

To copy and paste, select the text and then place the cursor on the text and
hold down the CTRL key. Now drag the cursor to the new position and release the
mouse button. The selected text is copied to the new insertion point.

Figure 6.8
The Clipboard
toolbar
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Your turn
1 Complete each task before moving on to the next task. Save the document at least at 

the end of each step.
a Call the document ‘holiday’ and include your name or initials in the name.
b List the places where you would like to go for a holiday. Press ENTER at the end of 

each place name to move to a new paragraph.
c List the places in order of preference. Use cut and paste to re-order them.
d Next to each place, provide a one-sentence reason why you would like to go there.

The reason is to be contained in the same paragraph.
e After you have entered the reasons check the order of places. Use cut and paste if 

you wish to change the order again.
f Print a copy of the document.
g Copy the material for the first five choices, create a new document and copy the

material to it. Save the new document.
2 Refer to your word-processing manual or on-line help and write down how you can move

the cursor to the beginning and end of a word, line, sentence, paragraph, screen, page 
and document.

3 Key in the following line:

This is line number

a Copy the line.
b Paste the line into the document three times. There should now be four lines.
c Add the numbers at the end of each line so that they appear as below.

This is line number 3
This is line number 4
This is line number 2
This is line number 1

d Using cut and paste (or drag and drop) select the lines and put the lines in the correct
order, numbers 1 to 4. How many cut and pastes does it take to do this?

Entering text

Text first, format later
With a word processor the text can be entered and altered until the content and
the layout is satisfactory. Generally it is best to enter the text first and format the
document later.

Devote time and attention to keying in your ideas first, pay less attention to
typing and keyboard errors as they can be corrected later.
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Tips for entering text
The standard rules for entering text with a word processor are:

• only press the ENTER key at the end of a paragraph. Let ‘word wrap around’ put
words on to the next line within a paragraph

• leave a single space after a full stop
• do not use a hyphen unless it is part of a name
• do not use the space bar apart from inserting a single space, for example, a

space between words
• check the uppercase or SHIFT key setting: ordinary text should be entered in

lower case, capital letters in upper case. 

Referring to text in a document
Text can be referred to as a character, word, line, sentence, paragraph or page.

What is a character?
A single key pressed on the keyboard will produce a character, such as:

• a lower case letter of the alphabet—for example, a, b
• a number—for example, 7, 9
• a punctuation symbol—for example, ?, “
• a symbol—for example, &, *, ®

The space bar should only be used to place a single space between words. Do
not use it to format text.

What is a word?
A word is a character or group of characters joined together with a space either
side. For example, ‘a’ and ‘this’ are both words.

What is a sentence?
A sentence is a group of words that makes sense on its own. A sentence starts with
a capital letter and is completed by the full stop. The full stop is sometimes
referred to as a ‘period’.

What is a line?
A line is made of characters placed together on a row between the left margin
and right margin. A line can be part of a sentence, part of a paragraph or a
separate paragraph.

What is a paragraph?
A paragraph is usually defined as text followed by a ‘return’ character. The
‘return’ forces the insert point to the left margin on the next line. This type of
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‘return’ is also referred to as a ‘hard’ return. Therefore a paragraph could be just
a single line followed by a return character. The ‘¶’ character often signifies this
‘hard return’. For example, the line shown in Figure 5.8 shows the line of text
and a paragraph marker.

What is ‘WYSIWYG’?
A word processor shows on screen what the document will look like when it is
printed. This is referred to as ‘what you see is what you get’ (WYSIWYG),
pronounced ‘wizzy-wig’.

Parts of a page
Check the paper size so that the document can be set with correct margins. A
standard paper size is A4. This is part of an internationally agreed convention on
paper sizes. A4 paper is 210 mm wide by 297 mm long. The margins are the blank
spaces surrounding the sides of the printed page. Figure 6.9 shows the parts of a
page.

Setting up your document
Word processors have default settings. A default setting is a value the software uses
for a setting until the user changes it.

A word processor may open with default settings for:

• screen font and size
• page size
• measurement unit for ruler
• margins
• page number
• printer.

Figure 6.9
An example of a
paragraph in a
word processor
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Figure 6.10
Reduced page view
showing margins

Left margin Right margin

Top
margin

bottom
margin

Text
length

Text width 

Figure 6.11
Default settings for
Page Setup
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On-screen information
A word processor provides on-screen information about the document and the
current settings. For example:

• position and types of tabs
• line spacing
• margins
• page width
• alignment of the lines
• line spacings.

These are set with the ruler and buttons on the formatting toolbar.

The ruler
The ruler provides a quick and easy way of setting document indents and tabs. It
also shows the current settings. From the ruler you can see the document
margins, left and right indents and any first line indents.

The margins are set in a dialogue box that is accessed by the command Page
Setup in the File menu. Then choose the Margins tab.

The default setting for Word has the text lining up with the margins at both the
right and left sides of the document.

Paragraph text can be set independently of the document margins using the
right and left indent markers.

An indent allows text to be set away from margins. It is used to specify how far
in from the margin you wish text to begin. For example, a left indent of 1 cm
starts the text 1 cm in from the left margin.

Page centring—horizontal and vertical
It is a good idea to have the left and right margins of equal width and the top and
bottom margins of equal width. This means that the page will be horizontally and
vertically centred on the paper when printed. A centred page looks balanced
whereas unequal margins tend to distract the reader.

Your turn
1 List the default settings of the word processor you are currently using.

Check the margins, paper size and the font name and size.
2 What settings do you prefer for the word processor? Why?

Figure 6.12
Example of a word
processor ruler
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Editing a document
When a document is in its final stages it needs to be carefully edited. Editing
involves checking the:

• spelling
• grammar
• punctuation
• paragraph organisation
• position of the page breaks in the document (called pagination).

Editing on screen
It can be difficult to get the feel of a document when proofreading on-screen.
Documents should be edited on-screen as much as possible before printing out.
However, it is most unlikely that all errors will be found by on-screen editing.

Checking the spelling
If a word in a document is incorrectly keyed in or incorrectly spelt it may be
found by using a spelling checker. Some dictionaries are based on American
spellings, although others are British and some Australian. For example:

Australian (British) Dictionary American Dictionary

colour color

centring centering

defence defense

A dictionary usually has two parts, the main dictionary and a user dictionary.
The main dictionary is usually selected when the software is installed. However, a
word used on a regular basis but not recognised by the main dictionary can be
put into the user dictionary. Names of people and place-names do not usually
appear in a dictionary and would need to be included in a user dictionary.

Figure 6.13
A spelling and
grammar checker
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Figure 6.12 shows the spelling checker window for Microsoft Word. A spelling
checker can:

• find a word that it considers spelt incorrectly
• suggest alternatives for the word
• add words to the user dictionary
• replace the word with the correctly spelt word.

Limitations of spelling checkers
Examine the spelling checker that comes with the word processor because:

• the quality of dictionaries can vary
• if a word is spelt correctly but used in the wrong context it will not be

detected—for example, ‘their’ and ‘there’, ‘where’ and ‘wear’
• names of people and places are usually not included
• the same two words in a row may not be detected, for example, ‘the the’.

It may still be necessary to consult the printed dictionary to check that you are
using a word correctly.

Accessing the dictionary
Microsoft Word provides a number of ways of
accessing the dictionary and correcting the
spelling.

One option is to check your spelling as
you type. When a word appears to be
incorrectly spelt, it is underlined in red.
Placing the cursor anywhere within the word
and then clicking on the right mouse button
brings up a list of alternative spellings from
which to select. 

A second option is to click the Spelling
and Grammar button on the toolbar. This
starts checking the spelling from the current
position of the cursor.

Figure 6.14
List of alternative spellings displayed
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Your turn
For the following exercises, check your answers with a partner if you need to.
1 Does the dictionary for the word processor you are using have a name? Is 

it British, American or Australian? How many words are in the dictionary?
2 Are the following words contained in the dictionary you are using?

a user-friendly
b dork
c AIDS
d yuppie

3 Suggest and find words that are relatively new to the language but not included in the
word processor dictionary.

4 Key your family name into a word-processing document and apply the spelling checker.
What is the result? Can you add your name to the dictionary? If so, how?

5 Each of the following sentences contains an error that would not be 
picked up by a spelling checker. Find the error.
a The boat was tied to a boy.
b Wear is the pencil?
c The car is parked over their.
d The plain flew in the air.

6 Type a sentence that includes the same word twice in a row and check the spelling. Does
the spelling checker pick up the duplicate word?

How should hard copy be edited?
A draft copy of the document needs to be edited carefully to pick up errors.
There are standard proofreading marks used to show the error and its correction.
The original error and the correction mark should be clear; sometimes, upon
reflection, the text is left as it was originally.

Your turn
1 How many meanings do the following words have in your printed dictionary: set, run, go,

open, strike, school, self? What do you think are the three most common uses of each
word?

2 Find the meaning of ‘green’ in your dictionary. Does the dictionary meaning reflect what
the word means today?

3 Does the term ‘user-friendly’ appear in your dictionary? What does the term mean? 
Give an example of how you would use the term?

Formatting a document
The final stage of document creation is formatting—that is, deciding how a
document is to look. A range of fonts and settings can be tried before a document
is completed.

Figure 6.15
Using the toolbar

spelling and grammar button
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Formatting refers to the way in which a document is arranged and is
determined by the:

• justification of lines
• alignment of lines
• amount of space between paragraphs
• use of fully blocked or indented paragraphs
• use of fonts and font styles.

Tips for consistent document formatting
The following will assist in formatting a document:
• if you use headings and sub-headings, make sure that they are 

consistent
• try to keep to one or two fonts throughout your document, perhaps with use of

bold and italic for emphasis
• use consistent line spacing throughout the text, this can then be changed to a

single spacing, line and a half, double or other spacing later.

Alignment buttons
Alignment buttons are located in the formatting toolbar in Microsoft Word. Place
the cursor anywhere within a paragraph and then click on the button for the
desired alignment on the toolbar.

To apply the alignment to more than one paragraph, select multiple
paragraphs and then click on the required button.

Alignment of lines and paragraphs
Text can be aligned left or right, centre or justified.

• Left aligned—each line will start on the left-hand margin. This is a normal
default style for most word processors. This style will leave a ragged right
margin.

This text is left aligned.
This text is left aligned.This text is left aligned.
This text is left aligned.This text is left aligned.This text is left aligned.

• Right aligned—each line will finish on the right hand margin. You may use this
to give a story a dramatic effect on a particular line or lines. This style will
produce a ragged left margin.

This text is right aligned.
This text is right aligned.This text is right aligned.

This text is right aligned.This text is right aligned.This text is right aligned.

• Centred—each line will be placed an equal distance from the left- and right-
hand margins. If the left and right margins are the same the line will be on the
centre of the page. This style is often selected for headings so that they stand
out. Never use spaces to try and centre text—always use the centre alignment
button.

Figure 6.16
Formatting buttons
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This text is centred.
This text is centred.This text is centred.

This text is centred.This text is centred.This text is centred.

• Justified—each line will start on the left-hand margin and finish on the right-
hand margin. The spacing between the words is altered to ensure that this
occurs. This is most commonly adopted for books, where it is considered better
to have the lines balanced.

This text is justified at both left and right margins. This text is justified at both left and
right margins. This text is justified at both left and right margins. This text is justified at
both left and right margins.

Your turn
1 Key in the following sentence.

The white sails of the Sydney Opera House are like the sails of the yachts on the harbour.
2 Copy and paste the line into the document three times.
3 Format the first line as left aligned.
4 Format the second line as right aligned.
5 Format the third line as centred.
6 Format the fourth line as justified.
7 Compare your result with the lines below.

The white sails of the Sydney Opera House are like the sails of the yachts 
on the harbour.

The white sails of the Sydney Opera House are like the sails of the yachts 
on the harbour.

The white sails of the Sydney Opera House are like the sails of the yachts 
on the harbour.

The white sails of the Sydney Opera House are like the sails of the yachts on the 
harbour.

Fonts
A font is a type style used to represent a character. Each font’s name refers to a
family of characters. Many of the popular fonts have been used in the printing
industry for hundreds of years.

Figure 6.17
True type fonts
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Each family of fonts includes upper and lower case letters, special characters
and a range of formatting options such as bold, italic and outline.

The font used should be chosen to increase legibility of the document.
Microsoft Windows uses TrueType fonts. These display the same image on the
monitor as when printed on a compatible printer.

Most word processors are able to display a range of fonts on the screen. The
size of a font is referred to in ‘points’. A point is a printing industry measure—
one point equals 1/72 inch. For example, a font in 12 point would be 1/6 of an
inch in height.

There are two options for typefaces, serif and sans serif. Serif fonts have
additional strokes like small tails at the ends of the characters. The following are
examples of three serif fonts (each is set in 14 point):

Times New Roman
Garamond
New Century Schoolbook

Sans serif fonts do not have these finishing strokes. The following are examples
of three sans serif fonts (each is set in 14 point):

Arial

AvantGarde
Helvetica

This is how the main characters of the font ‘Times New Roman’ would appear:

abcdefghijklmnopqrstuvwxyz  123456789 

This is how the main characters of the font ‘Helvetica’ would appear:
abcdefghijklmnopqrstuvwxyz  123456789

The font selected for a document will depend on the purpose of the document.
The font ‘Times New Roman’ is suited to a formal document such as a report;
‘Helvetica’ is suited to less formal documents such as an advertising flyer or
brochure.
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Your turn
1 The letter k is shown in upper and lower case in the Times and Helvetica fonts (48 point

size). What are the differences?

Times k Helvetica k Times K Helvetica K
2 The following are examples of fonts. What differences can you note 

between them?

Geneva
✮❅◗ ✹❏❒❋

Courier
Bookman

3 Do you like using different types of fonts? Why? List three fonts that you like using.

Variation in font size and style
Many word processors offer variations in font size and style. Figure 6.17 shows the
alternatives available for each font in Microsoft Word.

Figure 6.18
Alternative font
styles and sizes
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Variation of font size
Varying font sizes can make headings stand out. The size of a heading can be set
according to its importance in the document. An important heading would
usually appear in a larger font size. Normal text font size is 10 or 12 depending on
the type of font.

Variations of font style
Table 6.2 shows the variations in font characteristics offered by word processors.

Table 6.1

Feature Example Use

Plain This text is plain The default setting, this can be altered by the user.

Bold This text is bold Use for headings and important words in a document.

Italic This text is italic Use for emphasis on words in a document.

Underline This text is in underline Used for hyperlinks.

OOuuttlliinnee TThhiiss  tteexxtt  iiss  iinn  oouuttlliinnee Use only in special cases, difficult to read for large amounts of
text.

ShadoShadoww This text is in shadoThis text is in shadoww Use only in special cases, difficult to read for large amounts of
text.

Combination of font styles
Some of the above styles can be combined such as:

This text is in bold italic
Bold and italic are used regularly. Underline, outline and shadow are not easy

to read and should only be used for special purposes. They should not appear in
a document that contains a large amount of text. For example, it is difficult to
distinguish the letters in the following line, which is in an outline font.

TThhee  uussee  ooff  ccoommppuutteerrss  iinn  wwoorrdd  pprroocceessssiinngg

Figure 6.19
Font sizes

Times in 9 point size.

Times in 10 point size.

Times in 12 point size.

Times in 14 point size.

Times in 18 point size.

Times in 24 point size.

Times in 36 point size.
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Your turn
1 Key the following text into your word processor. Select the line and format the line in a

font that has a 12-point size.

My favourite dessert is vanilla ice cream covered in chocolate and nuts.

a Copy the line and paste it back into the document to make three lines.
b Leave the first line formatted as plain text.
c Format the second line in bold.
d Format the third line in italics.
e Compare your screen display with the example below.

My favourite dessert is vanilla ice cream covered in chocolate and nuts.
My favourite dessert is vanilla ice cream covered in chocolate and nuts.
My favourite dessert is vanilla ice cream covered in chocolate and nuts.

What is a tab?
When the TAB key is pressed once, the cursor will move to a pre-set position on
that line. Tabs are useful when setting out simple lists, tables and numbers in a
document. 

Tabs may also be used to exchange data within spreadsheets and databases.
Microsoft Word has default settings for:

• the position of the tabs—every 1.27 cm
• the type of tab—a left tab.

Types of tabs
Microsoft Word has four types of tab stops:

• left tabs—text aligns to the left edge of the tab stop
• right tabs—text aligns with the right edge of the tab stop
• centre tabs—text is centred on the tab stop
• decimal tabs—columns of numbers are aligned on the decimal point.

Setting tabs
A tab can be set by:

• selecting the type of tab at the left end of the ruler
• clicking in the required position on the ruler.

The icon representing the tab appears on the ruler.
A tab can also be set by:

• selecting the Tabs command from the Format menu
• entering the tab setting and tab type in the dialogue box.

Figure 6.20
Tab types on the
ruler
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Tabs may be altered after the text has
been entered—click on the tab and
drag it to the new location. Once the
tab is reset, the selected text will
move to the new position.

A tab may be removed by clicking
on it and dragging it down from the
ruler into the document.

Figure 6.21
The Tabs dialogue
box

Figure 6.22
Tab types and how
they set the text
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Tables
A table can be used to organise data in rows and columns. Tables can also be
formatted to allow borders and backgrounds.

In Word use the Insert table command from the Table menu. A prompt for the
table size creates the table.

Data is entered in each cell of the table. Each cell may contain text, numbers or
an image.

The column and row heights may be easily altered. Borders and shading assist
in making a table an excellent way of presenting data in a document.

Non-printing characters
Many of the characters used to format a document are not printed. These are
called non-printing characters and include the following:

• spaces—pressing the space bar
• tabs—pressing the TAB key
• carriage returns—pressing the RETURN/ENTER key.

Figure 6.23
Creating a table

Figure 6.24
An example of a
table

State/Territory Capital

New South Wales Sydney

Victoria Melbourne

Queensland Brisbane

South Australia Adelaide

Western Australia Perth

Tasmania Hobart

Northern Territory Darwin

Australian Capital Territory Canberra



106 First Byte

In Microsoft Word, these characters may be displayed on the screen by pressing
the Show/Hide button near the right side end of the standard toolbar. This button
toggles the characters on and off.

Printing a document
Before trying to print a document, make sure that the printer is connected and
turned on. Also ensure that the correct printer driver has been chosen. The
default printer is selected in the Printers folder.

Print preview
The Print Preview command on the File menu in Microsoft Word enables you to
see how each page will look before it is printed. This view is a reduced size view. It
is very useful for checking where page breaks occur and adjusting them when
necessary.

Printout of final copy
Final copy should be printed when the:
• page breaks are set correctly
• headings are all formatted correctly
• spelling and grammar have been checked.

It is advisable to print a draft copy of a document for checking before 
printing the final copy. Inkjet printers offer the option of printing out a fast, draft
copy before printing the final high quality one.

Your turn
Make a draft copy and a final copy printout of a document. Compare the two. What are the
differences regarding:
• the print quality
• the time taken to print?

What identifying information should be included in an assignment?
When submitting an assignment the following details should be included:

• date • teacher
• school name • the nature of the task (e.g., homework, essay)
• student’s name • student’s year level
• the task or question • subject
• due date.

Show/Hide button

Figure 6.25
The Show/Hide
button
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An example of this type of information and how it could be set out appears in
Figure 6.25.

Information:
Seaview Secondary College Homework: ‘Where in Time is
Name: Hala El Kishen Carmen Sandiego?’
Year Group: 8C Date: 21 March 2005
English: Ms Javsoski Due: 23 March 2005

Your turn
1 What information would you record for an assignment you currently have to complete?
2 Set out the details in Figure 6.26 differently. For example, key information—such as

name—could be in a bold font. The title could be on a separate line. Compare your 
setting out with the example in Figure 6.26.

Tips for setting out paragraphs
The following tips may help the readability of a document:

• break text into paragraphs of reasonable length
• leave a blank line between paragraphs
• use subheadings within the text
• headings should be in a larger font size than body text
• use bold and italics for emphasis not underline
• make the margins wide enough to allow comments to be easily written.

What are headers and footers?
For a document with many pages, information identifying the document can be
included on each page. Information at the top of each page is called a header, at
the bottom it is called a footer. Figure 6.26 shows the position of a header and a
footer.

English Homework Hala El Kishen: Class 8C
Due: 23 March 2006 Teacher: Ms Javsoski
Date: 21 March 2006
Software being reviewed
1 ‘Where in time is Carmen Sandiego?’

Seaview Secondary College

‘Where in Time is Carmen Sandiego?’

8 point
aligned
right

13 point
bold
centre

18 point
bold
centre

8 point
aligned
left

Figure 6.26
Layout for an
assignment
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How to set out headers and footers
Figure 6.27 shows where to position a header. Where possible make the header
and footer one line. The font for a header or footer can be different from the rest
of the text.

A page number is usually put in a header or footer. To do this:

• view the header or footer
• enter the word ‘Page’ and the symbol to start automatic numbering.

English Novel Review

Page 4

Header

Footer

Figure 6.27
Position of header
and footer

Figure 6.28
The layout of a
header or footer

Figure 6.29
Entering a page
number in a footer
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Your turn
1 Set up a header for an assignment.
2 Set up a footer that automatically enters the date.
3 How would you save the details so you could adapt it to another assignment later?

Templates
A template in Microsoft Word is a document that stores various styles, formats and
preferences. Templates are used to create standard formats and styles so that a
consistency in document appearance can be achieved.

A document that is used repeatedly with minor modifications should be set up
as a template.

Microsoft Word documents that are templates are stored with ‘.dot’ extension.
When a template is opened, the document is not named and will need to be saved
with a different name when used.

Microsoft Word uses a file called NORMAL.DOT that is used as a template for new
documents, unless the user chooses differently. Clicking the New button on the
toolbar opens a blank document based on the normal template. 

Using templates
To use a template, choose New from the File menu and click on the required tab
in the dialogue box. Now select the template that you wish to use.

Figure 6.30
Selecting a 
template
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Your turn
1 Open a new, blank document. Choose Page Setup from the File menu.

a What is the paper size?
b What are the values for the top and bottom margins?
c Alter the paper size and then click the Default button.
d Alter the top and bottom margins.
e Start a new document and see if your changes are reflected in that 

blank document.
2 Set up a template that contains your name, address and contact details, which you can

use for your own letterhead.
3 Create a table in Word that reflects your school timetable.

Review questions
1 List the four most important advantages of using a word processor for writing.
2 Explain what ‘word wrap-around’ means.
3 How often should a document file be saved?
4 The following steps are involved in the creation of a document. List them in their most

likely order. Compare your answer with Figure 6.4 (p. 85).

• enter information
• print a hard copy of the document
• name the document/file
• edit the hard copy
• check the page set-up and alter the default settings
• create a backup copy of the file
• run the spelling checker through the document
• edit the document on the screen.

Figure 6.31
Some of the
templates available
in Microsoft Word

WORKSHEETWORKSHEET
2333232233

Creating and
using a
template
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5 What is a cursor? List the ways a cursor can be moved around a document. How is the
cursor used to insert text?

6 How is text in a word processor selected?
7 When would you use copy and paste rather than cut and paste?
8 Distinguish between the following: a character; a word; a sentence; a paragraph.
9 Explain the following parts of a page: top margin, left margin, right margin, bottom

margin.
10 What should you look for when editing a document?
11 How useful are spelling checkers? In your answer give examples of errors that will and

will not be detected by a spelling checker.
12 Briefly explain the ways a word processor can align paragraphs.
13 In what ways are the Times and Helvetica fonts different?

Now try these
1 Write an advertisement for a garage sale you are going to have. Put the address, details of

goods for sale and the date and time in the advertisement.
2 Write a birth notice for the public notices section of the newspaper.
3 Write a review of your favourite television program. In your review list the main

characters and explain why the program appeals to you. Confine your review to 200
words.

4 Write a brief profile of your favourite pet, pop star, sports star or public figure.
5 Imagine you are to spend a year in the Australian outback. What are the most important

things you would like to take? Explain why you have chosen each item.

▲

?


